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1.1 Introduction
You have probably already enjoyed on the beach, the freshness brought by a breeze blowing from the sea towards
the land. This sea breeze is a thermally induced wind which typically occurs near coastal boundaries. The sea
has a greater heat capacity than land, so during the day, the surface of the sea warms up more slowly than the
land’s surface. As the temperature of the surface of the land rises, the land heats the air above it and reduces its
density. On the other hand, the air above the sea is cooler and has a relatively higher density, causing air near
the coast to flow towards the land. The strength of the sea breeze is directly proportional to the temperature
difference between the land and the sea.

The purpose of this experimental session is to gain insight into the developpement of the atmospheric mixed
layer and the sea breeze phenomenon via an experimental fluid model of the convective boundary layer (CBL).
We will mimic the atmospheric convection in a water tank ! The density gradient of the lower troposphere will
be reproduced with a linear salt stratification while the impact of solar heating will be forced by a thermal
source located at the tank bottom. As in the lower troposphere the thermal convection will be constrained by
the density stratification. Therefore, the height of the mixed layer, induced by the turbulent convection, will be
controlled by the intensity of the thermal source and the initial density stratification.

The experiments are divided into two sessions: (1) In the first session you will become acquainted with the
proposed experimental model and use it to study the temporal evolution of an idealized atmospheric boundary
layer; (2) In the second session you will generate a differential heating at the bottom of the tank to observe,
understand and measure the sea breeze phenomenon.
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Figure 1.1: Physical and dynamical process of the Sea breeze (upper panel). Laboratory modelisation of a
convective boundary layer heated from below (lower panel)

1.2 Materials and methods

1.2.1 Modelization of the atmosphere

One of the phenomena driving the convection cell described above is the gradient of air density in the atmosphere
induced by a gradient of temperature. Strictly speaking, the relevant phenomenon is the gradient of potential
temperature, which is the gradient of temperature corrected to compensate the compressibility of air.

We could model the density gradient of the atmosphere in a water tank using salt. We will first fill the
tank with salty water with a concentration of dissolved salt which increases from the bottom to the top of the
tank. The solar radiation is modeled by heating the bottom of the tank (orange pipes on Figure 2). This is
accomplished by hot water flowing in pips in the bottom of the tank. We can monitor its flow rate, as well as its
temperature before and after the bottom of the tank. We will therefore quantify the heat flux and study how the
convective boundary layer (CBL) evolve with time. To visualize the flow in the tank, buoyant plastic particles
are released in the fluid and lightened with a vertical laser sheet. The motion of the particles then reveals the
convective area in the stratified tank.
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Figure 2 Schematic description of the heating system which mimic the solar heating at the bottom of the
tank.

1.2.2 Methods
1.2.2.1 Laser

It is important that you read this section carefully.
In order to follow the motion of fluid during the experiments, a laser sheet will be used. One or two 50mW lasers
will be used. This power is ten times higher than the 5mW threshold at which a laser directed to your eye can
leads to irreversible lesions. For this reason, only the instructor is allowed to handle the laser. If you
need to turn it on or off or to move it, please ask the instructor to do so.
When the laser beam widens, the danger decreases, but it is very important to avoid any risk of focusing the
laser beam. Therefore, put on the protection glasses and be careful whenever you do something in the tank and
the laser is on. In particular, you must remove your watch, rings, bracelets or anything that could reflect and
focus the laser beam, and avoid abrupt movements.

1.2.2.2 Salinity gradient

The salinity gradient is established with a double bucket. The right container is filled with fresher water, of
smaller salinity Smin while the left container is filled with saltier water, of higher salinity Smax. A tube connects
the first container to the experimental tank and the fresh water will slowly fill the tank from the bottom. However,
when the level of the right container diminish, due to the U-tube connectiing the two containers, the saltier water
enter and mixes with the fresh one. Hence, the mean density of the right container increases as far as the tank is
fllled. The result is that the tank is filled with water of linearly increasing salinity (and therefore density) from
Smin to Smax. The formation of this linear gradient of salt and density can be verified by using a refractometer
to test samples taken at different heights in the experimental tank.

Figure 3 The double bucket system and the heating system.
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1.3 First experiment: Atmospheric boundary layer
In the first day of this lab session, you will study the growth of a convective boundary layer (CBL) when the
tank bottom is uniformly heated from below, to understand and validate the proposed experimental model of
the atmosphere, .

1.3.1 Preliminary discussions
• What do you expect to observe when the bottom is uniformly heated ?

• How do you expect that a boundary layer will form and what would be its characteristic features ?

• What parameters would you choose to describe the evolution of the boundary layer over time ?

1.3.2 Experimental study
In order to warm up the water which will be used for the heating circuit, turn the heating in the circuit’s water
container on 45◦C.

1.3.2.1 Preparation of the material

Measurement of salinity gradients At the beginning of the session you will find the experimental tank already
filled, with a linear salinity gradient established. Using a sampling tube, a refractometer and a ruler, verify that
the salt concentration gradient is linear. Measure the magnitude of this gradient: fill up a table with the salinity
as a function of height and verify that the stratification is linear.

S(z) = .

Visualization In order to observe and capture the motions of the fluid, you will inject small plastic beads
(orgasol powder) in the tank and illuminate them with the red laser. The plastic beads being hydrophobic, you
need to mix the plastic beads with a small amount of soap and add water little by little so that the powder mixes
well into the water.

Video recording Place the camera in front of the experimental tank and plug the cable in the plug at
the bottom of the camera. Launch the camera software ‘pixelink’ and get used with the options. The play (or
preview) button allows you to visualize in real time the images captured by the camera. You can thus adjust the
position and the focus of the camera. If there is too much reflection on the tank, you can use a black sheet to
shield the camera from the room light. Today, you will simply take one photo at given times. Choose the image
format ‘tiff’, 1 frame, and the path where you want to save the figure. You can create your own folder in ‘My
Documents/FDSE/’. Test the settings by clicking on Capture.

Post-processing The acquisition and post-processing of the data will be done with ImageJ. You will use
ImageJ to measure the evolution of the thickness of the boundary layer. Load the test image you captured with
Pixelink. A box opens, check ‘convert to gray scale’ and click ‘ok’. Because of the camera position, the image
is rotated of 90◦. You can correct this by clicking on Image>Transform> 90◦ Left. Use the line tool to draw
a line from the bottom of the tank to the top. The shortcut ‘ctrl+M’ will give you the length in pixel of this
line. Measure the corresponding length with a rule and deduce the pixel/cm scale. You will use this procedure
to measure the height of the developing boundary layer, and use the scale to convert pixels in centimeters.

1.3.2.2 Boundary layer experiment

Turn on the pump connected to the heating container in order to start the flow in the heating circuit and the
timer. Adjust the pump setting so that the flow rate is 0.4L/min. Bubbles in some pipes may prevent a smooth
and homogeneous circulation of the heating fluid. It is important that you check regularly that there are no
bubbles. If some of them appear, you can eliminate them by pinching the pipes.

Add some of the bead solution near the tank’s bottom and top and ASK THE INSTRUCTOR to turn
on the laser. At this point, people who will keep working on the experimental tank (for example to take the



Cours 1: 1-5

measurements) must take off their watch, rings or bracelets as they may reflect and focus the laser beam, which
is highly dangerous, and put on the protection glasses.

At regular intervals, measure the different parameters which characterize the evolution of the system. Do not
forget to add time to time some buoyant particles when the height of the CBL increases.

1.3.2.3 Discussions

• Plot your results using Matlab/Excel or any software you are faliliar with.

• During the development of the boundary layer, does the salinity gradient remain constant?

• What about the evolution of the temperature in the tank?

• How much energy is provided to the tank through time ?

• Using ‘cftool’ (Matlab)/ ‘fitting tool (Excel)’, can you find a law for the evolution of the height of the
boundary layer ?

1.3.3 Theoretical study

Derivation of the law driving the temporal evolution of the height of the boundary layer
We assume that, once the boundary layer is established, the tank is divided in two parts: the boundary layer
with height zbl, homogenized by convection with uniform temperature Tbl and salinity Sbl, and the upper layer
with a constant temperature T0 and a linear salinity gradient S(z) = S0 − γz, as initially (see Figure 1.2). The
evolution of the boundary layer is driven by the heat flux provided to the system and the homogenization of the
layer.

Figure 1.2: Salinity and temperature distribution model

The density ρ of water is assumed to be a linear function of temperature T and salt concentration S:

ρ = ρ0 + αS(z)− βT.

Show that the conservation of the total quantity of salt in the boundary layer allows to find a relation between
the salt concentration Sbl and the height of the boundary layer zbl:

Sbl = . (1.1)

By equating the density of the two layers at the interface, find a relation between zbl and Tbl:

Tbl = . (1.2)
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Write the first law of thermodynamics for the boundary layer in order to find a relation between the heat flux
Q provided from the bottom and the temperature change in the boundary layer:

Q = (1.3)

By using the relation (1.2) and by assuming Q constant, integrate (1.3) to obtain a law for the time evolution
of the boundary layer thickness:

zbl = . (1.4)

Now, compare this theoretical law to the measurements.

1.4 Second experiment: Sea breeze

In this second experiment, half of the tank’s bottom is heated up to a temperature T1, while the other half is
kept at a smaller temperature T2 < T1.

1.4.1 Preliminary discussions

• How does this setup model the sea breeze phenomenon?

• What parameters would you choose to follow?

1.4.2 Experimental study

1.4.2.1 Preparation of the material

In this experiment, you will measure the velocity of the flow field in the convective cell. To this purpose, in the
camera software ’Pixelink’, choose to take 2 frames per second and to capture 2 frames in avi format. Capture
one test image in your personal folder. Open the file with ImageJ, convert it in grayscale and flip it of 90◦. To
facilitate the data analysis, you need to reduce the image to the region of interest: with the ’Rectangular’ tool,
select the region of the boundary layer and apply your choice with Image>Crop. The PIV can now be performed.
Select Plugins>PIV>Iterative PIV (basic). You can begin with the default parameters. ImageJ performs a PIV
computation and shows the result to you. If the result is satisfactory, accept and save the result. Otherwise, test
another set of parameters. It is important that during the experiment, you save all the results with a generic
name, for example ’PIV*.txt’ where ’*’ is the number of the measurement.

1.4.2.2 Post-processing of the results

You can analyze the velocity of the fluid in the convective cell. To this purpose, open the PIV.m file in Matlab.
Change the parameters: path to your data, pixel to centimeter scale, number of result files to be analyzed
and x-positions to be tested. It will provide you with the maximum, minimum and mean displacements at the
x-positions of your choice.

1.4.2.3 Discussion

Using the frame rate, you can deduce the velocities in the convective cell.

• Are the velocities the same everywhere in the cell?

• How the velocity field evolves with the height of the cell?

• Does the evolution law obtained in the boundary layer experiment remain valid?

• How can you explain this?
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1.4.3 Further experiment
In the final part of the session you can perform a second experiment, where you can investigate the effect on the
sea breeze phenomenon of changing one of the relevant physical parameters controlling it. This would also allow
you to produce the density gradient by yourself. What parameter would you propose to study?

1.4.3.1 Preparation of the experimental tank

If not already done, stop the heating system and the pump. Empty the experimental tank using a siphon and
buckets. To fill it with the density gradient, you will use the method described in the Materials and Methods
section. The experimental protocol is the following :

• Check that all valves are closed and that no tube of the filling circuit has been detached.

• Fill the unsalted compartment with 13L of water with a bucket, then the salted water compartment with
13L of water at the target density (You may use the salt soulbility table in Appendix A). Turn on the
agitator.

• Open the filling and connection valves.

• Check that all the pipes of the filling system are provided with water. If not, or if there are bubbles in some
of them, pinch the other pipes to force the water into the pipes with no flow or with bubbles. This may
create bubbles in the foam, which will disrupt the experiment. Use the cylindrical metal stick to gently
press the foam and get the bubble out of the foam.

• Prepare two liters of water at the target density. When the end of the filling approaches, close the valve
connecting the two containers and add this water to the ’unsalted compartment’. Before the water level
reaches the level of the pipe hole, close the valve. This will avoid creating new bubbles.

1.4.3.2 Experiment

Repeat the experiment using a different value of the parameter of your choice.

1.5 Conclusion
Characterize the extent of applicability and the limitations of your experimental results to model the real case
of the sea breeze.

1.6 References
Website of the Cooperative Institute for Meteorological Satellite Studies:
http://cimss.ssec.wisc.edu/wxwise/seabrz.html.
Website of the National Weather Service: http://www.srh.weather.gov/srh/jetstream/ocean/seabreezes.htm.
Image copyrights
http://cimss.ssec.wisc.edu/wxwise/seabrz.html
http://www.cycloneroad.com/gallery.htm
http://www.valerieannebartlett.co.uk/page14.htm
http://www.prh.noaa.gov/hnl/kids/activities.php
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A Table of salt solubility in water


